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Purpose

This manual provides information on

• The contents of the Access Resource CD

• How to install and configure AccelePort Xp drivers

Audience

This manual is intended for experienced system administrators. It assumes that the administrator is
proficient with the Operating System on which the driver will be installed.

Scope

This manual provides information on the contents of the CD and on the installation and
configuration of each of the AccelePort Xp drivers. It does not cover the following:

• Hardware installation, which is covered in a separate hardware installation card included in
the AccelePort Xp package

• Specifications, certifications, cabling or troubleshooting, which can be found in the online
documentation on the Access Resource CD

Conventions Used in This Manual

Following are the customary styles used in this document:

• A special font is used for any input you need to enter. For example,

mkpconn

• Keys and titles of dialog boxes, indexes, menu bars, windows, etc. appear exactly how
they appear on the keyboard or on the screen.

• The word, Choose, can mean Click, Point, Select, Hit, Press and so on.
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About the Access Resource CD

Drivers on the Access Resource CD

The Access Resource CD holds drivers for the following operating systems:

• Linux

• AIX

• SCO OpenServer

• SCO UnixWare

• Solaris

• Novell NetWare

Menu Program Options
To make it easier for you to find what you need on the CD, Digi provides a menu program that
automates tasks. From the menu, you can do the following:

• Install drivers
• View release notes
• View product documentation

About the CD-Based Product Documentation
In addition to this manual, driver documentation is provided on the Access Resource CD in
HTML format. Digi recommends viewing this documentation with Internet Explorer 4.0 (or later)
or Netscape Navigator 4.0 (or later).

Hardware installation cards, which are provided with your Digi adapter, are duplicated on the CD
in Adobe PDF format. To view or print this documentation, you must have the Adobe Acrobat
Reader installed on your system. A Microsoft Windows version of the Acrobat Reader (version 3)
is available on the Digi CD. You can find the file to install it (rs32e301) in the /adobe folder.
Users on other operating systems can find the reader on the Adobe web site.

Note: Some hardware installation cards are legal-sized documents (14” x 8.5”). If you want to
print PDF documents this size on letter-sized paper (11” x 8.5”), you must specify “fit to page” in
the Acrobat print function.

About the Release Notes on the CD
Use the Release Notes to find out more about the current release of software on the CD. Release
Notes are text files that can be viewed using the View Release Notes option.
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System Requirements

The AccelePort Xp OpenServer device driver is designed to work on all versions of SCO
OpenServer 5.

Accessing the CD from an SCO OpenServer System

 1. Place the CD in the system CD drive.

 2. Mount the CD by entering the following:

mount -r -f ISO9660 device-name mount-directory

Note:  device-name is the name assigned the CD, and mount-directory is the
directory in which the CD is mounted.

 3. Navigate to the directory in which the CD is mounted.

 4. Enter the following:

./setup

The CD menu appears.

Master Setup Process

This Overview outlines the general procedure for installing and configuring the SCO OpenServer
device driver for AccelePort Xp adapters.

 1. Install the adapter. See the appropriate hardware installation card for more information.

 2. Install the SCO OpenServer driver. See one of the following: Installing the Driver: CD on
page 2-3 or Installing the Driver: Downloaded on page 2-3.

The installation software creates devices in /dev. See: Device Names on page 2-5.

 3. If you plan to use PortAssist Manager, load the PortAssist Manager Communication Agent.
See Loading the PortAssist Manager Communication Agent: SCO OpenServer on page 2-4.

 4. If you are using 8-pin RJ-45 connectors and need modem control signals, configure the
ports for ALTPIN operation. See: Using 8-Pin RJ-45 Connectors on page 2-5.

 5. If you have terminals with attached printers, the TTY devices may be configured to support
transparent printing. See Appendix B for information about transparent printing.
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Installing the Driver: CD

Use this procedure to install a driver from the Digi CD. This procedure assumes that you have
already started the Digi CD front end program.

Procedure

 1. Choose your operating system.

 2. Choose the driver for your Digi product.

 3. Choose Install Software. Follow the prompts. 

Installing the Driver: Downloaded

Use this procedure to install a downloaded Digi SCO OpenServer driver. 

Procedure

 1. Download the appropriate driver package file.

 2. Copy the downloaded package file to a directory on the OpenServer system.

 3. Log in as root on the SCO OpenServer system.

 4. Change to the directory into which you copied the package file.

 5. Enter the following command:

custom -i -p misc:dgap -F `pwd`/file_name

where file_name is the name of the downloaded driver package.

 6. Choose Software > Install New.

 7. Follow the prompts as appropriate.
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Loading the PortAssist Manager Communication Agent: SCO
OpenServer

Use this procedure to start the PortAssist Manager communication agent and, if you so choose, to
ensure it is automatically loaded each time the system is initialized. PortAssist Manager can
monitor and manage your Digi adapters. To read about and use PortAssist Manager, see the
PortAssist Manager Users Guide on the Digi Access Resource CD.

Requirements

The drivers for the Digi adapters to be monitored by PortAssist Manager must have already been
installed.

Procedure

 1. Determine how you will use the communication agent.

If you want to manually load the communication agent (without booting),  enter at the
command line prompt:

/etc/dgap/agent [UDP_Port_Number] &  

where UDP_Port_Number is the number of the communication agent’s UDP port, if
different from the default.

Note: The default UDP number is 2362, which was assigned to Digi by the Internet
Assigned Number Authority (IANA). Although you can change this port number, it should
not be necessary. If another application uses it, the best way to resolve the conflict is to
reconfigure the application to use another UDP port number, one that has not been assigned
by the IANA. 

If you want the communication agent automatically loaded at startup, continue with the next
step.

 2. Open the startup script /etc/rc2.d/S95apras with vi (or your choice of text editor).

 3. Note the following command, commented-out with a number sign:

#/etc/dgap/agent &

 4. Remove the number sign (#), save the file and exit the editor. The communication agent will
be loaded automatically at the next system startup.

Note: If you no longer want the communication agent loaded automatically, replace the number
sign (#) in the command in the startup script.
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Device Names

AccelePort Xp devices are named according to the following conventions:

/dev/ttyhbp, /dev/prhbp

ttyh  Base name

prh Base name for DigiPRINT ports

b Adapter number (1-8)

p Port Identifier (a-p, A-P)

Lower case letters denote non-modem control ports. These ports do not require DCD to be
asserted before they can transmit data.

Upper case letters denote modem control ports. These ports require DCD to be asserted
before they can transmit data.

Example:

Port 4 of Adapter 2 is /dev/ttyh2d. The same port with modem control is /dev/ttyh2D. The
corresponding DigiPRINT devices are /dev/prh2d and /dev/prh2D.

Using 8-Pin RJ-45 Connectors

Use this information to configure devices to use alternating wiring if you will be using 8-pin RJ-
45 plugs with Digi’s 10-pin RJ-45 jacks. 

Use the ditty parameter, altpin, to enable the use of 8-pin RJ-45 connectors. The command

ditty altpin /dev/ttyh2d

swaps the functions of the DCD and DSR inputs so that DCD becomes available on pin 1 of an 8-
pin RJ-45 connector. The device /dev/ttyh2d is just an example. Specify your device instead.
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fastbaud Data Rate Mapping

Use this procedure to enable data rates that exceed the maximum data rate supported by some
UNIX operating systems. If your operating system supports data rates up to (or beyond) 921600,
this procedure is unnecessary. See fastbaud Data Rate Mapping Table on page A-6 for a table of
correspondences showing how data rates are mapped when fastbaud is enabled.

Procedure

 1. Enter the following command at a command prompt:

ditty fastbaud [device_name]

where device_name is the name of the TTY device on which you want fastbaud
activated. If no device is specified, the command acts on stdout.

 2. Repeat Step 1 for all devices that require fastbaud data rate mapping. (The commands may
be added to a startup script to cause them to run automatically whenever the system is
started.)

To cancel fastbaud data rate mapping, enter the following command:

ditty -fastbaud [device_name]

Example:

If fastbaud is active for a port on an AccelePort Xp adapter, setting the data rate to 600 results in
an actual data rate of 921600.

Configuring a Device for a Terminal

Use this procedure to configure a Digi serial device for a terminal. See your operating system
documentation for more information on configuring a serial device for a terminal.

Procedure

 1. Connect a serial cable between the port and terminal. 

 2. Edit the /etc/inittab file on the SCO OpenServer system. Change the lower-case device to
the proper speed, data bits, stop bits and parity bit. Do this by editing the letter or number at
the end of the line for the port (the default is m which corresponds with 9600 8,1,N). See
/etc/gettydefs for /etc/inittab letter and number definitions.

 3. Enable the port for login by entering this command at a prompt:

enable device

where device is the name of the Digi device.
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Configuring a Device for a Printer

Use this procedure to configure a Digi serial device for a printer. Consult your operating system
documentation for more information on configuring a serial device for a printer.

Procedure

 1. Connect a proper cable between the port and printer. 

 2. If you are using 8-pin RJ-45 cabling from the Digi serial port to the modem, enable altpin
by inserting a ditty command or altpin option to an existing ditty command for the port in
the file /dev/rc.d/8/userdef.

Example

ditty altpin device

where device is the name of the Digi device.

Note: By inserting the command in the startup file, it will execute every time the system is
booted. For the altpin option to take effect immediately, enter the ditty altpin command at a
UNIX prompt.

 3. Insert either of following commands at the end of the file /etc/rc.d/8/userdef:

cat < /dev/device > /dev/null &

or

sleep 999999 < /dev/device &

These commands force the specified port to stay open, thus preserving any “non-sticky”
options. Substitute your port name in the command.

 4. Insert any other necessary ditty commands at the end of the file /etc/rc.d/8/userdef. The
command ditty can be used to change the settings of a port. For additional information on
ditty, see Appendix A: Setting TTY Options (UNIX Systems).

As an example, the following command will set the port ttya01 to a speed of 38400, disable
software flow control, and enable hardware flow control on the port:

ditty 38400 -ixon -ixany -ixoff ctspace device

By placing the ditty command in /etc/rc.d/8/userdef, it will be executed whenever the
system is booted.

 5. Reboot the system or enter the ditty command manually for the new settings to take effect.
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Configuring a Device for a Modem

Use this procedure to configure a Digi serial device for a Dial-in/Dial-out modem connection.
Configuring a device for a modem requires familiarity with both the operating system and the
modem being used. While the following procedure is sufficient for most cases, it may be
necessary to take additional steps to properly configure your modem or to set up the operating
system for a specific application.

Procedure

 1. Connect a serial cable between the port and modem.

 2. Power the modem on.

 3. If you are using 8-pin RJ-45 cabling from the Digi serial port to the modem, enable altpin
by inserting a ditty command or altpin option to an existing ditty command for the port in
the file /dev/rc.d/8/userdef.

Example

ditty altpin device

where device is the name of the Digi device.

Note: By inserting the command in the startup file, it will execute every time the system is
booted. For the altpin option to take effect immediately, enter the ditty altpin command at a
SCO Unix prompt.

 4. Edit the /etc/inittab file on the SCO Unix server. Change the upper-case device to the letter
o by editing the letter or number at the end of the line for the device. See /etc/gettydefs for
inittab letter and number definitions.

 5. Disable the modem control and non modem control devices for the port:

disable modem-control-device
disable non-modem-control-device

where modem-control-device is the name of the modem control device for the port
and non-modem-control-device is the name of the non modem control device for
the port.

 6. Edit the file /usr/lib/uucp/Devices. Add a Direct line for the device like this:

Direct ttyh1a - 38400 direct device

The “D” in Direct has to be the first character on the line.

 7. Comment out any ACU lines relating to this device until dial-in is working properly.

Some applications may require an ACU entry in the Devices file. If an application requires
an entry, refer to the modem manual or to the modem manufacturer for the correct modem
initialization string, and to the SCO Administration handbook for guidance on setting up an
appropriate ACU entry that uses this initialization string.
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 8. Connect to the modem. At a root prompt, enter this command

cu -l /dev/device -s 38400

where device is the name of the non modem control device for the port.

 9. Set the modem to answer after the first ring with this command:

ats0=1

 10. Train the modem to the port speed with this command:

at&w

 11. Enter any other desired modem commands.

 12. Disconnect from the modem by entering a tilde-period:

~.

 13. Configure flow control on the port. Hardware flow control is typical and can be configured
by inserting this command at the end of the file /etc/rc.d/8/userdef:

ditty rtspace ctspace -ixon device

 14. To add dial-in capability, enter this command at a root prompt:

enable device

In SCO OpenServer, the upper case device name is for dial-in, the lower-case name is for
dial-out and modem configuration.

Uninstalling the Driver

Use this procedure to remove the Digi device driver from the kernel. The Development Kit is not
required, although the link kit must be installed.

Procedure

 1. Log onto the console as super-user (root), and enter this command: 

custom

 2. Choose Software > Remove from the menu that appears.

 3. Choose the Digi driver.

 4. When prompted to boot the new kernel by default, choose Yes for the new kernel to boot by
default. Choose No if there is a specific reason for this new kernel not to boot by default.

 5. Exit custom.

 6. Enter the following command to shut the system down and boot the new kernel:

shutdown -y -g0



AccelePort Xp Software Installation Guide2-10



SCO UnixWare Software Setup 3-1
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Accessing the CD from an SCO UnixWare System

 1. Place the CD in the system CD drive.

 2. Mount the CD using the following command:

mount -r -F cdfs device-name mount-directory

Note:  device-name is the name assigned the CD, and mount-directory is the
directory in which the CD is mounted

 3. Navigate to the directory in which the CD is mounted.

 4. Enter the following command:

./setup

The CD menu appears.

System Requirements

The AccelePort SCO UnixWare device driver is designed to work on UnixWare revision 7.0 1 or
higher. Depending on the specific revision of UnixWare, operating system patches (available from
SCO’s website) may be required. The table below shows the patches required for each revision.

Operating System Revision Required Patches

7.0.1 erg710756d (or above d, if available)
ptf70553b (or above b, if available)
ptf7096d (or above d, if available)

7.1.0 ptf7413c (or above c, if available)

7.1.1 No patches required
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Master Setup Process

Use this general procedure to install and configure the SCO UnixWare device driver for
AccelePort Xp asynchronous adapters.

 1. Install the adapter. See the appropriate hardware installation card for more information.

 2. Install the SCO UnixWare driver. See: Installing the Driver: CD on page 3-3 or Installing
the Driver: Downloaded on page 3-3.

The installation software creates devices in /dev. See Device Names on page 3-5 for a
description of the naming conventions for AccelePort Xp devices.

 3. If you plan to use PortAssist Manager, load the PortAssist Manager Communication Agent.
See About PortAssist Manager in the documentation on the Access Resource CD
and Loading the PortAssist Manager Communication Agent: SCO UnixWare on page 3-4
on page.

 4. Configure the ports for ALTPIN operation if you will be using 8-pin RJ-45 connectors and
need modem control signals. See: Using 8-Pin RJ-45 Connectors on page 3-5.

 5. If you have terminals with attached printers, the TTY devices may be configured to support
transparent printing. See Appendix B for information about transparent printing.

Installing the Driver: CD

Use this procedure to install a driver from the Digi CD. You should have already started the Digi
CD front end program.

Procedure

 1. Choose an operating system.

 2. Choose an adapter.

 3. Choose Install Driver. 

 4. Follow the prompts.

Installing the Driver: Downloaded

Use this procedure to install a Digi driver after you have downloaded it from the Digi web site.

Procedure

 1. Enter: 

pkgadd -d driver_name

where driver_name is the path to the downloaded driver file.

 2. Follow the prompts.
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Loading the PortAssist Manager Communication Agent: SCO
UnixWare

Use this procedure to start the PortAssist Manager communication agent and, if you so choose, to
ensure it is automatically loaded each time the system is initialized. PortAssist Manager can
monitor and manage your Digi adapters. To read about and use PortAssist Manager, go to online
the PortAssist Manager Users Guide.

Requirements

The drivers for the Digi adapters to be monitored by PortAssist Manager must have already been
installed.

Procedure

 1. Determine how you will want to use the communication agent.

If you want to manually load the communication agent (without booting),  enter at the
command line prompt:

/etc/inst/nd/mdi/dgdxb/agent [UDP_Port_Number] &  

where UDP_Port_Number is the number of the communication agent’s UDP port, if
different from the default.

Note: The default UDP number is 2362, which was assigned to Digi by the Internet
Assigned Number Authority (IANA). Although you can change this port number, it should
not be necessary. If another application uses it, the best way to resolve the conflict is to
reconfigure the application to use another UDP port number, one that has not been assigned
by the IANA. 

If you want the communication agent automatically loaded at startup, continue with the next
step.

 2. Open the startup script /etc/rc2.d/S95mkstz with vi (or your choice of text editor).

 3. Note the following command, commented-out with a number sign:

#/etc/inst/nd/mdi/dgdxb/agent &

 4. Remove the number sign (#), save the file and exit the editor. The communication agent will
be loaded automatically at the next system startup.

Note: If you no longer want the communication agent loaded automatically, replace the number
sign (#) in the command in the startup script.
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Device Names

AccelePort Xp devices are named according to the following conventions:

/dev/term/hbp, /dev/prhbp

h Base name

prh Base name for DigiPRINT devices

b Adapter number (0-7)

p Port Identifier (a-h, A-H)

Lower case letters denote non modem control devices. These devices do not require
DCD to be asserted before they can transmit data.

Upper case letters denote modem control devices. These devices require DCD to be
asserted before they can transmit data, and software flow control is enabled by default.

Example:

Port 4 of Adapter 2 is /dev/term/h1d. The same port with modem control is /dev/term/h1D. The
associated DigiPRINT devices are /dev/prh1d and /dev/prh1D.

Using 8-Pin RJ-45 Connectors

Use this information to configure devices to use alternating wiring if you will be using 8-pin RJ-
45 plugs with Digi’s 10-pin RJ-45 jacks. 

Use the ditty parameter, altpin, to enable the use of 8-pin RJ-45 connectors. The command

ditty altpin /dev/term/h0a

swaps the functions of the DCD and DSR inputs so that DCD becomes available on pin 1 of an 8-
pin RJ-45 connector. The device /dev/term/h0a is just an example. Specify your device
instead.
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fastbaud Data Rate Mapping

Use this procedure to enable data rates that exceed the maximum data rate supported by some
UNIX operating systems. If your operating system supports data rates up to (or beyond) 921600,
this procedure is unnecessary. fastbaud Data Rate Mapping Table on page A-6 for a table of
correspondences showing how data rates are mapped when fastbaud is enabled.

Procedure

 1. Enter the following command at a command prompt:

ditty fastbaud [device_name]

where device_name is the name of the TTY device on which you want fastbaud
activated. If no device is specified, the command acts on stdout.

 2. Repeat Step 1 for all devices that require fastbaud data rate mapping. (The commands may
be added to a startup script to cause them to run automatically whenever the system is
started.)

To cancel fastbaud data rate mapping, enter the following command:

ditty -fastbaud [device_name]

Example:

If fastbaud is active for a port on an AccelePort Xp adapter, setting the data rate to 600 results in
an actual data rate of 921600.
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Configuring a Device for a Modem

Use these procedures to configure an AccelePort device for a Dial-in or Dial-out modem
connection. Configuring a device for a modem requires familiarity with both the operating system
and the modem being used. While the following procedures are sufficient for most cases, it may be
necessary to take additional steps to properly configure your modem or to set up the operating
system for a specific application.

Procedure 1: Dial-in Modem Configuration

 1. Use the SCO Admin tool to fully configure the modem. Enter:

scoadmin modem 

Use the SCO online help for assistance with scoadmin.

 2. Connect to the modem with the following command:

cu -l /dev/term/h1D 

(The device h1D used here is just an example.) 

 3. If necessary for your modem, enable auto-answer by entering this modem command:

ats0=1&w

 4. Disconnect from the modem by entering tilde-period:

~.

 5. Use the stty or ditty commands to set any required TTY parameters that you did not set in
Step 1. For help with stty, see the UnixWare online help. For help with ditty, see Appendix
A, Setting TTY Options (UNIX Systems).

Procedure 2: Dial-out Modem Configuration

1. Use the SCO Admin tool to configure the port. Enter:

scoadmin serial

Configure the port as Outgoing Only, and set the Port Type to Software Flow Control.

Use the SCO online help for assistance with scoadmin.

2. Use the stty or ditty commands to set any required TTY parameters that you did not set in
Step 1. For help with stty, see the UnixWare online help. For help with ditty, see
Appendix A, Setting TTY Options (UNIX Systems).
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Configuring a Device for a Printer

Use this procedure to configure an AccelePort device for a printer. See your operating system
documentation for more information on configuring a serial device for a printer and configuring an
lp device.

If you are using a printer attached to a terminal, use the corresponding transparent print device.
For example, if your terminal is on /dev/term/h1d then the attached printer would be on /dev/prh1d
(see Appendix B: Transparent Print Setup (UNIX Systems)for more information about transparent
printers).

Procedure

 1. Insert either of following commands at the end of the file /etc/rc2.d/S99printer:

cat < /dev/term/h1d > /dev/null &

or

sleep 999999 < /dev/term/h1d &

These commands force the specified port to stay open, thus preserving any “non-sticky”
options. This example uses the port /dev/term/h1d. Substitute your port name in the
command.

The file S99printer is just an example. This file may need to be created. An “S99” file
with a different name may be used instead.

 2. Insert any necessary ditty commands at the end of the file /etc/rc2.d/S99printer. The
command ditty can be used to change the settings of a port. For additional information on
ditty, see Appendix A: Setting TTY Options (UNIX Systems).

As an example, the following command will set the port h1d to a speed of 38400, disable
software flow control, enable forced carrier, and enable hardware flow control on the port:

ditty 38400 forcedcd -ixon -ixany -ixoff ctspace h1d

NOTE: The Data Carrier Detect (DCD) signal needs to be active (high) on the port for the
port to function properly with a printer. The ditty forcedcd option can be used to accomplish
this when the DCD signal is not made active through cabling.

 3. If you are configuring a transparent print device, add ditty commands to set the transparent
print parameters. See Appendix B for more information.

 4. For the ditty command to take effect immediately, enter the command manually at a system
root prompt, or reboot the system.

 5. Configure the device as a printer by running  scoadmin printer.
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 6. The printer should be ready for use. To print a file, use the command

lp -d printer_name file_to_print

where printer_name is replaced with the name given to the printer in sysadm or
scoadmin, and file_to_print is replaced with the name of the file to print.

Configuring a Device for a Terminal

Use this procedure to configure an AccelePort device for a terminal. See your operating system
documentation for more information on configuring a serial device for a terminal.

Procedure

 1. Start the SCO Serial Manager by entering this command at a SCO command prompt:

scoadmin serial

 2. Configure the ports as needed. Use the SCO online help for additional information.

 3. Exit the SCO Serial Manager.

Uninstalling the Driver

Use one of the following procedures to uninstall a Digi SCO UnixWare driver.

Procedure 1: Using SCO Admin

 1. Choose SCO Admin in the window environment or enter scoadmin at a root prompt.

 2. Open the Software Management folder in the System Administration window.

 3. Open the Application Installer.

 4. Choose digiras from the All Applications Currently Installed window. 

 5. Choose Remove.

Procedure 2: Using pkgrm

 1. Enter the command, pkgrm digiras.

 2. Follow prompts to remove the driver.
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Accessing the CD from an AIX System

 1. Place the CD in the system CD drive.

 2. Mount the CD using the following command:

mount -r -v cdrfs device-name mount-directory

Notes: (a) device- name is the name assigned the CD. (b) mount-directory is the
directory in which the CD is mounted.

 3. Navigate to the directory in which the CD is mounted.

 4. Enter the following command:

./setup

The CD menu appears.

Requirements and Considerations

Read this section before beginning the AccelePort Xp driver installation.

• It is important to read any release notes that may be included with the installation media.

• The AccelePort Xp driver supports AIX version 4.2.1 or newer.

Master Setup Process

This Overview outlines the general procedure for installing and configuring the AIX device driver
for AccelePort asynchronous adapters.

 1. Install the adapter. See the appropriate hardware installation card for more information.

 2. Install the AIX driver. See Installing the Driver: CD on page 4-3, or Installing the Driver:
Downloaded on page 4-3.

 3. Create the devices. See Creating and Configuring TTYs on page 4-5.

 4. If you have terminals with attached printers, the TTY devices may be configured to support
transparent printing. See Appendix B for information about transparent printing.



AIX Software Setup 4-3

Installing the Driver: CD

Use this procedure to install a driver from the Digi CD. You should have already started the Digi
CD front end program.

Procedure

 1. Choose an operating system.

 2. Choose an adapter.

 3. Choose Install Driver. 

 4. Follow the prompts.

Installing the Driver: Downloaded

Use this procedure to install a downloaded Digi AIX driver.

Procedure

 1. Download the appropriate driver file.

 2. If necessary, transfer the driver file to the AIX system.

 3. Log in as root on the AIX system.

 4. Enter this command to begin the installation:

smit install_latest

 5. When prompted, specify the path to the driver file.

An Install Software window appears. This window contains a list of installation parameters.

 6. Change the parameters as necessary.

 7. Choose OK to begin the installation. The Digi AIX driver installation should proceed to a
successful conclusion. Respond to any prompts that follow as appropriate.

 8. Reboot the system to complete the installation.
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Loading the PortAssist Manager Communication Agent: AIX

Use this procedure to start the PortAssist Manager communication agent and, if you so choose, to
ensure it is automatically loaded each time the system is initialized. PortAssist Manager can
monitor and manage your Digi adapters. To read about and use PortAssist Manager, go to the
online PortAssist Manager Users Guide.

Requirements

The drivers for the Digi adapters to be monitored by PortAssist Manager must have already been
installed.

Procedure

 1. At a root prompt on the AIX system, change the working directory to /usr/lbin/tty with the
following command:

cd /usr/lbin/tty

 2. Determine how you will want to use the communication agent.

If you want to manually load the communication agent (without booting),  enter at the
command line prompt:

./agent [UDP_Port_Number] &  

where UDP_Port_Number is the number of the communication agent’s UDP port, if
different from the default.

Note: The default UDP number is 2362, which was assigned to Digi by the Internet
Assigned Number Authority (IANA). Although you can change this port number, it should
not be necessary. If another application uses it, the best way to resolve the conflict is to
reconfigure the application to use another UDP port number, one that has not been assigned
by the IANA. 

If you want the communication agent automatically loaded at startup, continue with the next
step.

 3. Enter the command:

mkitab "pamagent:2:respawn:/usr/lbin/tty/agent > /dev/console
2>&1"

Note: If you no longer want the communication agent loaded automatically, delete the following
from the /etc/inittab file:

"pamagent:2:respawn:/usr/lbin/tty/agent > /dev/console
2>&1"
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Creating and Configuring TTYs

Use this procedure to create and configure TTY devices in AIX. The procedure for creating and
configuring TTY devices for Digi serial ports is similar to the procedure used to create standard
AIX TTY devices. For complete information, refer to your AIX documentation.

Procedure

 1. Log onto the system as super-user (root).

 2. Enter this command: smit mktty

The Add a TTY menu appears.

 3. Choose Add a TTY.

A TTY type list appears.

 4. From the list, choose tty rs232 Asynchronous Terminal

A Parent Adapter window appears.

 5. Choose the appropriate Digi adapter.

An Add a TTY window appears.

 6. Configure the fields as necessary. The only required entry is the PORT number field. Note
that the first port on an adapter is port number 0.

 7. If the Data Carrier Detect signal is not wired between the port and the peripheral device
attached to it, set Ignore Carrier Detect to enable.

 8. Choose OK then DONE to complete the TTY addition.

The name of the TTY that was created is displayed when smit command processing has
completed.

 9. Repeat steps 6 through 8 for each TTY.
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Configuring a Device with smit

Digi serial devices can be configured with smit using this procedure. Refer to AIX documentation
for complete information on the smit utility.

Procedure

 1. Enter this command at a root prompt on the AIX console: smit tty

 2. Choose Change / Show Characteristics of a TTY.

 3. Choose a TTY device. Here is an example of a listed device: tty2 Available 04-04-01-02
Asynchronous Terminal In this example, the first 04 is the bus number. The second 04 is the
slot number. The number 01 is the dm device number. The number 02 is the port number. A
dialog panel appears with fields to configure the port.

 4. Configure the fields as necessary. The only required entry is the PORT number field.

 5. If the Data Carrier Detect signal is not wired between the port and the peripheral device
attached to it, set Ignore Carrier Detect to enable.

 6. Press Enter to complete the TTY addition.

Using 8-Pin RJ-45 Connectors

Using an 8-pin RJ-45 plug in Digi’s 10-pin RJ-45 jack results in the loss of the modem signals RI
(Ring Indicator) and DCD (Data Carrier Detect). RI is rarely necessary, but DCD is required when
using modems with Unix ports.

To enable the use of 8-pin plugs, a stty-digi parameter, altpin, has been provided. The command

stty-digi altpin

swaps the functions of the DCD and DSR inputs so that DCD becomes available on pin 1 of an 8-
pin RJ-45 connector.

Important: The stty-digi command configures device attributes until the system is rebooted. Use
a chdev command to permanently set device attributes.

chdev -l [tty#/lp#] -a [attribute]=[value]

where:

[tty#/lp#] is the name of the device to change

[attribute] is the attribute or option to set. This can be any stty-digi option.

[value] is the value assigned to the attribute
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fastbaud Data Rate Mapping

Use this procedure to enable data rates that exceed the maximum data rate supported by some
UNIX operating systems. If your operating system supports data rates up to (or beyond) 921600,
this procedure is unnecessary. See fastbaud Data Rate Mapping Table on page A-6 for a table of
correspondences showing how data rates are mapped when fastbaud is enabled.

Procedure

 1. Enter the following command at a command prompt:

stty-digi fastbaud [device_name]

where device_name is the name of the TTY device on which you want fastbaud
activated. If no device is specified, the command acts on stdout.

 2. Repeat Step 1 for all devices that require fastbaud data rate mapping. (The commands may
be added to a startup script to cause them to run automatically whenever the system is
started.)

To cancel fastbaud data rate mapping, enter the following command:

stty-digi -fastbaud [device_name]

Example:

If fastbaud is active for a port on an AccelePort Xp adapter, setting the data rate to 600 results in
an actual data rate of 921600.
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Configuring a Device for a Terminal

This procedure will configure a Digi serial device to use a login. Consult your operating system
documentation for more information on configuring a serial device for a terminal.

Procedure

 1. Connect a proper cable between the port and terminal. Refer to the AccelePort Cable Guide
on the Digi Access Resource CD.

 2. At an AIX root prompt, enter this command:

smit tty

 3. Choose Change/Show Characteristics of a TTY. Choose a TTY device. Here’s an example
of a listed device:

tty7 Available 00-00-04-02 Asynchronous Terminal

In this example, the first 00 is the bus number. The second 00 is the slot number. The
number 04 is the sa or dm device number. The number 02 is the port number.

 4. Set Enable LOGIN to enable.

 5. Set BAUD rate to match the terminal’s baud rate.

 6. Set PARITY, BITS per character, and Number of STOP BITS to match the terminal’s
settings.

 7. Set TERMINAL type to match the type of terminal on the port. This is important if you will
be using transparent printing on the auxiliary port of the terminal.

 8. Set FLOW CONTROL to be used to match the flow control used by the terminal

 9. If DCD is not physically wired high in your cable, set Force Carrier to enable.

 10. Press Enter to complete the TTY configuration.
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Configuring a Device for a Printer

Use this procedure to configure a Digi serial device for a printer. Consult your operating system
documentation for more information on configuring a serial device for a printer.

Note: This procedure is valid for Digi ports that will have printers directly connected to them.
Printers connected to terminals use transparent printing.

Procedure

 1. Connect a proper cable between the port and printer. Refer to the AccelePort Cable Guide
on the Digi Access Resource CD.

 2. Enter this command at a root prompt: smit printer

 3. Choose Printer/Plotter Device.

 4. Choose Add a Printer/Plotter.

 5. Choose osp Other serial printer.

 6. Choose rs232.

 7. Choose a dm device.

 8. Enter a port number in the PORT number field. Note: The number is zero-based, meaning
00 is the first port.

 9. Set BAUD rate, PARITY, BITS per character, and number of STOP BITS to match the
settings of the printer.

 10. Set FLOW CONTROL to be used to match the flow control used by the printer.

 11. If the Data Carrier Detect signal is not wired between the port and the peripheral device
attached to it, set Ignore Carrier Detect to enable.

 12. Press Enter to complete the printer addition.
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Configuring a Device for a Modem

This procedure will configure a Digi serial port for a Dial-in/Dial-out modem connection.
Configuring a port for a modem requires familiarity with both the operating system and the
modem being used. While the following procedure is sufficient for most cases, it may be
necessary to take additional steps to properly configure your modem or to set up the operating
system for a specific application.

Procedure

 1. Connect a proper cable between the port and modem. Refer to the online AccelePort Cable
Guide on the Digi Access Resource CD.

 2. Turn the modem on.

 3. Access a root prompt on the AIX system.

 4. Add an entry for the device in the file /usr/lib/uucp/Devices. The following example allows
a connection of 38400 baud to the device:

Direct tty3 - 38400 direct

 5. Change the device ownership and group using these two commands:

chown uucp /dev/tty#

chgrp uucp /dev/tty#

where # is the port number.

 6. Make sure the device is disabled with this command:

pdisable tty#

This command is not needed if the port is set to share (bi-directional).

 7. Enter this cu command to connect to the modem:

cu -ml /dev/device -s 38400

where device is the name of the TTY device. The modem should respond with an AT
prompt.

 8. Train the modem to the port speed by entering this command at the AT prompt:

at&w

 9. Terminate the connection by entering a tilde followed by a period followed by the Enter key
at the AT prompt:

~. <Enter>

 10. Enter smit by entering this command at an AIX command prompt:

smit tty



AIX Software Setup 4-11

 11. Choose <Change/Show Characteristics of a TTY>.

 12. Select the tty device. This is an example of a listed device:

tty7 Available 00-00-04-02 Asynchronous Terminal

In this example, the first 00 is the bus number. The second 00 is the slot number. The
number 04 is the sa or dm device number. The number 02 is the port number.

 13. Set Enable LOGIN to share.

 14. Set BAUD rate to the modem’s highest configurable baud rate.

 15. Set PARITY, BITS per character, and number of STOP BITS to match the settings of the
modem.

 16. Set FLOW CONTROL to be used to match the flow control used by the modem.

Uninstalling the Driver

Follow this procedure to uninstall the AIX driver.

Procedure

 1. Log onto the system as super-user (root).

 2. Enter this command:

smit install_remove

A dialog panel appears.

 3. Choose List if you need to determine the name of the Digi driver to remove.

 4. Alter the field SOFTWARE name to digidm.pci.rte.

 5. Alter the field PREVIEW only to no.

 6. Choose OK.

This prompt appears: Are You Sure?

 7. Choose OK.

The uninstallation should proceed to a successful conclusion.
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Accessing the CD from a Linux System

 1. Place the CD in the system CD drive.

 2. Mount the CD using the following command:

mount -t iso9660 -r /dev/cdrom /mnt/cdrom

 3. Navigate to the cdrom directory:

cd /mnt/cdrom

./setup

The CD menu appears.

System Requirements

The AccelePort Xp Linux device driver is fully supported with all kernels in the 2.2 tree.

This product continues to support kernel 2.0.36 and later kernels in the 2.0 tree.

This product has been tested with the following distributions:

• RedHat 5.2, 6.0, 6.1, 6.2

• Debian Linux 2.1

• TurboLinux Server 4.0

Master Setup Process

Here are the major steps required to set up an AccelePort Xp adapter in a Linux system.

Overview of Setup Steps

 1. Install the adapter. See the appropriate hardware installation card for more information.

 2. Install the Linux device driver package. See Installing the Driver: CD on page 5-3 or
Installing the Driver: Downloaded on page 5-3. This procedure also loads the driver and
builds the devices.

 3. Configure the driver. See Printing Configuration on page 5-6 or Terminal and Dial-in
Modem Configuration on page 5-7.

 4. If you plan to use PortAssist Manager, load the PortAssist Manager Agent. See Loading the
PortAssist Manager Communication Agent: Linux on page 5-4.

 5. If you have terminals with attached printers, the TTY devices may be configured to support
transparent printing. See Appendix B for information about transparent printing.
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Installing the Driver: CD

Use this procedure to install a driver from the Digi CD. You should have already started the Digi
CD front end program.

Procedure

 1. Choose an operating system.

 2. Choose an adapter.

 3. Choose Install Driver. 

 4. Follow the prompts.

Installing the Driver: Downloaded

Use this procedure to install a device driver that has been downloaded from the Digi ftp site.

Procedure

 1. Log in as super user (root).

 2. Install and make the driver package by entering the following command:

rpm -ihv driver_name

where driver_name is the name of the downloaded driver package. The driver will be
installed in /usr/src/dg/dgdm/drv/linux.

 3. Enter the following command to load the driver and build the devices:

/etc/rc.d/init.d/dgdm start

 4. Add the new services to the /etc/rc.d hierarchy by entering the following command:

chkconfig --add dgdm

Note that not all distributions of Linux provide the chkconfig command; if the command is
unavailable, add the services by the preferred method for your distribution.
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Loading the PortAssist Manager Communication Agent: Linux

Use this procedure to start the PortAssist Manager communication agent and, if you so choose, to
ensure it is automatically loaded each time the system is initialized. PortAssist Manager can
monitor and manage your Digi adapters. To read about and use PortAssist Manager, go to
PortAssist Manager Users Guide on the Digi Access Resource CD.

Requirements

The drivers for the Digi adapters to be monitored by PortAssist Manager must have already been
installed.

Procedure

 1. Determine how you will want to use the communication agent.

If you want to manually load the communication agent (without booting),  enter at the
command line prompt:

/usr/sbin/dgdm_agent [UDP_Port_Number] &  

where UDP_Port_Number is the number of the communication agent’s UDP port, if
different from the default.

Note: The default UDP number is 2362, which was assigned to Digi by the Internet
Assigned Number Authority (IANA). Although you can change this port number, it should
not be necessary. If another application uses it, the best way to resolve the conflict is to
reconfigure the application to use another UDP port number, one that has not been assigned
by the IANA. 

If you want the communication agent automatically loaded at startup, continue with the next
step.

 2. Open the startup script /etc/rc.d/init.d/dgdm with vi (or your choice of text editor).

 3. Note the following pair of entries:

# Set the following variable to ON to autostart the PortAssist Comm Agent.

PAM=OFF

 4. Change PAM=OFF to PAM=ON. The communication agent will be loaded automatically at
the next system startup.

Note: If you no longer want the communication agent loaded automatically, change PAM=ON
back to PAM=OFF .
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Device Names

The devices will be created in /dev/dg/dgdm, linked to /dev, and will have the following format:

Dial-in devices: ttyGa_xx, where a is the adapter number and xx is the device number.

Dial-out devices: cuga_xx, where a is the adapter number and xx is the device number.

DigiPRINT transparent printer devices: lpGa_xx, where a is the adapter number and xx is the
device number.

Device and adapter numbers start at zero.

Example:

Port 4 of Adapter 3 is /dev/cug2_03. The same port with modem control is /dev/ttyG2_03. The
DigiPRINT device is /dev/lpG2_03.

Using 8-Pin RJ-45 Connectors

Use this information to configure devices to use alternating wiring if you will be using 8-pin RJ-
45 plugs with Digi’s 10-pin RJ-45 jacks. 

Use the ditty parameter, altpin, to enable the use of 8-pin RJ-45 connectors. The command

ditty altpin /dev/cug2_03

swaps the functions of the DCD and DSR inputs so that DCD becomes available on pin 1 of an 8-
pin RJ-45 connector. The device /dev/cug2_03 is just an example. Specify your device instead.
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fastbaud Data Rate Mapping

Use this procedure to enable data rates that exceed the maximum data rate supported by some
UNIX operating systems. If your operating system supports data rates up to (or beyond) 921600,
this procedure is unnecessary. See fastbaud Data Rate Mapping Table on page A-6 for a table of
correspondences showing how data rates are mapped when fastbaud is enabled.

Procedure

 1. Enter the following command at a command prompt:

ditty fastbaud [device_name]

where device_name is the name of the TTY device on which you want fastbaud
activated. If no device is specified, the command acts on stdout.

 2. Repeat Step 1 for all devices that require fastbaud data rate mapping. (The commands may
be added to a startup script to cause them to run automatically whenever the system is
started.)

To cancel fastbaud data rate mapping, enter the following command:

ditty -fastbaud [device_name]

Example:

If fastbaud is active for a port on an AccelePort Xp adapter, setting the data rate to 600 results in
an actual data rate of 921600.

Printing Configuration

You have two options in configuring your printers with Linux drivers.

• Use the Linux printool command.

• Set up the printers manually. To install a printer manually, add the following lines to the end
of the inittab file when you are using hardware flow control with a Digi standard cable:

DG01:2345:once: cat < /dev/ttyD1 > /dev/null &
dg01:2345:once:ditty ctspace altpin -ixon -ixoff 
-ixany /dev/ttyD1

Note: Use DG01 and dg01 for ttyD1, DG02 and dg02 for /dev/ttyD2, etc. Altpin should be used
only on an 8-wire cable with RJ-45 Digi connectors. If you use a 10-pin cable or if the Digi has a
DB25 connector, use -altpin.
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Terminal and Dial-in Modem Configuration

Digi ports are configured in the same way standard communication ports /dev/ttyS0 and /dev/ttyS1
are although the getty’s name that configures your port varies from system to system. The
following information is only meant to serve as a guide.

Following are examples of scripts for different operating systems.

• An example of a common RedHat terminal install script where getty is getty_ps would be:

dl:2345:respawn:/sbin/getty ttyD1 DT9600 vt100

• An example of a common Debian terminal install script where getty is agetty would be:

D1:23:respawn:sbin/getty -L ttyD1 19200 vt100

• An example of an mgetty modem script which is available both in RedHat and Debian is:

T3:23:respawn: /sbin/mgetty -x0 -s 115200 ttyD3

Note: Altpin should be off on Digi DB25 ports with a 10-wire cable. Modems wired to RJ-45 Digi
ports with 8-wire cable should have altpin turned on. You can do this by editing the
/etc/digiepca/rc.epca file, adding a line at the bottom of the file for each port. For example:

ditty altpin /dev/ttyD0
ditty altpin /dev/ttyD2

 

 Uninstalling the Driver

 1. Log in as super user (root).

 2. Kill all processes that use the dgdm device.

 3. Remove the device driver module by entering the following command:

/etc/rc.d/init.d/dgdm stop

 4. Enter rpm -e dgdm.
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Accessing the CD from a Solaris System

 1. Place the CD in the system CD drive.

 2. Mount the CD using the following command:

mount -r -F hsfs -o nomapcase device-name mount-directory

Notes: (a) device-name is the name assigned the CD. (b) mount-directory is the
directory in which the CD is mounted. (c): If the Vol Manager is running, the CD will be mounted
in /cdrom/device-name

 3. Navigate to the directory in which the CD is mounted.

 4. Enter the following command:

./setup

The CD menu appears.

Requirements and Considerations

Read this section before beginning the AccelePort Xp driver installation.

• The Solaris AccelePort Xp device driver works with Solaris SPARC and Solaris x86
operating systems. The earliest versions of Solaris the device driver supports are Solaris 2.6
on both the SPARC and the x86 platform. For the latest versions of Solaris supported, see the
Release Notes.

• The Digi AccelePort Xp device driver for Solaris is a loadable device driver; the software
development system is not required to create a new kernel.

• After installing the driver, release notes are available in the directory /opt/DIGIras. The ASCII
file name is release_notes.
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Master Setup Process

This Overview outlines the general procedure for installing and configuring the Solaris device
driver for AccelePort asynchronous adapters.

 1. Install the adapter. See the appropriate hardware installation card for more information.

 2. Install the Solaris driver. See: Installing the Driver: CD on page 6-3 or Installing Driver
Files for Solaris from a Download on page 6-3.

 3. If you plan to use PortAssist Manager, load the PortAssist Manager Communication Agent.
See Loading the PortAssist Manager Communication Agent: Sun Solaris on page 6-4.

 4. Configure the ports. See Device Configuration Overview on page 6-7.

 5. If you have terminals with attached printers, the TTY devices may be configured to support
transparent printing. See Appendix B for information about transparent printing.

Installing the Driver: CD

Use this procedure to install a driver from the Digi CD. You should have already started the Digi
CD front end program.

Procedure

 1. Choose an operating system.

 2. Choose an adapter.

 3. Choose Install Driver. 

 4. Follow the prompts.

Installing Driver Files for Solaris from a Download

Use one of these procedures to install a downloaded Digi Solaris device driver.

Procedure

 1. Download the appropriate driver file(s).

 2. If you have downloaded the driver file(s) from a system other than the Solaris system, copy
the file(s) to the Solaris system.

 3. Log onto the console as superuser (root).

 4. Enter this command:

pkgadd -d filename

where filename is the name of the downloaded driver file.

 5. Follow the prompts.
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Loading the PortAssist Manager Communication Agent: Sun Solaris

Use this procedure to start the PortAssist Manager communication agent and, if you so choose, to
ensure it is automatically loaded each time the system is initialized. PortAssist Manager can
monitor and manage your Digi adapters. To read about and use PortAssist Manager, go to
PortAssist Manager Users Guide on the Digi Access Resource CD.

Requirements

The drivers for the Digi adapters to be monitored by PortAssist Manager must have already been
installed.

Procedure

 1. Determine how you will want to use the communication agent.

If you want to manually load the communication agent (without booting), enter at the
command line prompt:

/opt/DIGIras/bin/pamagent [UDP_Port_Number] &

where UDP_Port_Number is the number of the communication agent’s UDP port, if
different from the default.

Note: The default UDP number is 2362, which was assigned to Digi by the Internet
Assigned Number Authority (IANA). Although you can change this port number, it should
not be necessary. If another application uses it, the best way to resolve the conflict is to
reconfigure the application to use another UDP port number, one that has not been assigned
by the IANA.

If you want the communication agent automatically loaded at startup, continue with the next
step.

 2. Open the startup script /etc/rc2.d/S90DIGIras with vi (or your choice of text editor).

 3. Note the following command, commented-out with a number sign:

# /opt/DIGIras/bin/pamagent &

 4. Remove the number sign (#), save the file and exit the editor. The communication agent will
be loaded automatically at the next system startup.

Note: If you no longer want the communication agent loaded automatically, replace the number
sign (#) in the command in the startup script.
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Device Names

Format

Device nodes can be found in /dev/DIGIras and are of the form bMMpNNs and bMMpNNm,
where MM is a zero-based, two-digit number (assigned by the operating system) designating the
adapter board, and NN is a zero-based number designating the port. Devices ending with the letter
m (modem-control) block on DCD on open; those ending in s do not. Devices that end in  m are
dial-in devices. Devices that end in s are dial-out devices. Links to these device nodes can be
found in /dev/term (m devices) and in /dev/cua (s devices).

Here are examples of the devices created for the first port of a with an adapter identification
number of 00.

Device Path/Name Example

Actual Standard Device (terminal) /dev/DIGIras/b00p00s

Actual Modem Device /dev/DIGIras/b00p00m

Standard Device Link (terminal) /dev/cua/n where n is a number assigned by the
operating system This device is linked to
/dev/DIGIras/b00p00s

Modem Device Link /dev/term/n where n is a number assigned by the
operating system

This device is linked to /dev/DIGIras/b00p00m

Transparent Print Device /dev/DIGIras/b00p00lp

Standard Device

Example: /dev/DIGIras/b00p01s

The default handshake method for these devices is XON/XOFF. Data Carrier Detect need not be
present to open the device. Once a connection is established and DCD becomes active, standard
devices behave in the same way as modem devices--subsequent loss of the Data Carrier Detect
signal will cause active processes on the port to be killed and the user will be automatically logged
off.

Modem Device

Example: /dev/DIGIras/b00p01m

These devices are sometimes referred to as “dial-in” devices. They are traditional UNIX ports with
modem control. They require Data Carrier Detect to be high before they will operate. RTS/CTS
handshaking is enabled by default. When used with a modem, the ports will wait for carrier before
sending out the login prompt.
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When used with a terminal or other device, it is usually wise to wire the Digi DCD signal to the
terminal’s DTR (Data Terminal Ready) line. When the terminal is turned on, the system outputs a
login prompt. When the terminal is turned off, any associated jobs are killed, and the user is
logged out.

Transparent Print Devices

Example: /dev/DIGIras/b00p01lp

The transparent print devices (DigiPRINT) can be used with auxiliary printer ports on terminals.
Output directed to a transparent print device goes out the auxiliary port of a terminal while the
user continues to use the terminal normally.

As an example, this ditty command configures a port to use transparent printing to a terminal
using wyse60 emulation. Note that the ditty command should specify the terminal device
(b00p01s), even though you use the transparent device (b00p01lp) to print.

ditty term wyse60 maxcps 80 bufsize 2000 maxchar 50
/dev/DIGIras/b00p01s
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Device Configuration Overview

Use these overviews of device configuration topics to decide which tool(s) you should use to
configure your devices.

admintool

Features
or
Description

• Is the Sun-provided device configuration utility

• Can configure a device for a terminal, modem or printer

• Can only be run from a window environment

• Has basic and advanced settings

• Requires links to Digi devices in /dev/term or /dev/cua before Digi
devices can be configured with it.

Uses • Configure general and advanced device settings

• Configure a device for a terminal, modem or printer

• Change device settings

Resources • Consult you Solaris documentation

• Refer to the man page for admintool

• See Configuring a Device with admintool on page 6-10.

ditty

Features
or
Description

• Is Digi’s device configuration program

• Is run from a command prompt

• ditty configuration is not always necessary if devices are configured
with admintool

• ditty commands should be included in a system startup file.

Uses • Manually configure Digi-specific device settings such as altpin or
forcedcd

• Configure printer devices. See Configuring a Device for a Printer on
page 6-13.

Resources • Refer to the man page for ditty

• See Using ditty on page 6-11and Appendix A: Setting TTY Options
(UNIX Systems) .
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pmadm

Features
or
Description

• Is the Sun-provided command-line program to enable and configure a
device for login

• Commands are typically long, include many options and can be
difficult for some users to use

Uses

• Enable a port monitor on a device. This is necessary to get a login
prompt on a port. Note that admintool automatically enables a monitor
on a port when a port is configured for a terminal or dial-in device.

• Change an attribute of an enabled device.

Resources

• Consult you Solaris documentation

• Refer to the man page for pmadm

• See Configuring a Device with pmadm on page 6-11

sacadm

Features
or
Description

• Is the Sun-provided server access controller administrator. This
command manages port monitors which are necessary to enable a port
for login. The default port monitor, zsmon, is sufficient for Digi ports
in many cases.

Uses • Adds or removes a port monitor

• starts or stops a port monitor

• enables or disables a port monitor

Resources • Consult you Solaris documentation

• Refer to the man page for sacadm

Configuring a Port for a:

Terminal Configuring a Device for a Terminal on page 6-12

This procedure describes how to configure a device for a terminal using
admintool.

Printer Configuring a Device for a Printer on page 6-13

This procedure describes how to configure a device for a printer using ditty.

Modem Configuring a Device for a Modem on page 6-14

This procedure describes how to configure a device for a modem using a
combination of admintool and ditty.
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Miscellaneous Topics

Transparent
Printing

Transparent printing is used to print to a printer that is connected to a terminal
where the terminal is directly connected to a Digi port. See Appendix B:
Transparent Print Setup (UNIX Systems)

altpin This option should be enabled on a port when an RJ-45 8-pin cable is used and
the Data Carrier Detect (DCD) signal is required. For example, altpin should be
enabled on a port where an RJ-45 8-pin cable is used with a modem. See Using
8-Pin RJ-45 Connectors on page 6-9.

fastbaud AccelePort Xp adapters support baud rates in excess of the maximum baud rate
supported by Solaris. To enable the use of these fast baud rates, a ditty
parameter, fastbaud, has been provided. See fastbaud Data Rate Mapping on
page 6-12.

Data Carrier
Detect (DCD)

In some cases, depending on your operating system requirements and/or your
device requirements, it may be necessary for the Data Carrier Detect (DCD)
signal to be active on a port before it will function. See Data Carrier Detect on
page 6-9.

Using 8-Pin RJ-45 Connectors

Using an 8-pin RJ-45 plug in Digi’s 10-pin RJ-45 jack results in the loss of the modem signals RI
(Ring Indicator) and DCD (Data Carrier Detect). RI is rarely necessary, but DCD is required when
using modems with UNIX ports.

To enable the use of 8-pin plugs, a ditty parameter, altpin, has been provided. The command

ditty altpin /path/device

(where /path/device is the path and device name of your Digi port) swaps the functions of
the DCD and DSR inputs so that DCD becomes available on pin 1 of an 8-pin RJ-45 connector.

Ditty commands should be manually inserted in the startup file /etc/rc2.d/S99ditty (or any other
file beginning with “S99” in the directory) so they are executed every time the system boots.

Data Carrier Detect

In some cases, depending on your operating system requirements and/or your device requirements,
it may be necessary for the Data Carrier Detect (DCD) signal to be active on a port before it will
function.

There are two ways to fulfill this requirement.
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Cabling

One way to fulfill the DCD requirement is to create a cable and have your device force the signal
high. See the AccelePort Cable Guide on the Access Resource CD.

ditty

Another way to fulfill the DCD requirement is to enable the forcedcd ditty option. See Using ditty
on page 6-11.

Configuring a Device with admintool

The Solaris system administration utility, admintool, can be used to configure Digi serial devices.

Note: In order to use admintool, The Digi devices need to be linked to devices in /dev/term and
/dev/cua.  These links are normally created when the driver is installed.  If these links are not there
they can be created manually.

Procedure

 1. Access admintool through a window interface, or entering this command at a root prompt:

admintool

 2. From the admintool window, select Browse > Serial Ports.

 3. Choose a device.

 4. Choose Edit > Modify.

 5. Configure the port as needed.
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Configuring a Device with pmadm

Use this procedure to configure a Digi device with pmadm. This procedure can be used from a
command line prompt in the absence of a window interface to the operating system. For additional
information and help on pmadm, consult your Solaris documentation.

Procedure

 1. Enter a pmadm command at a root prompt. Here is an example of a command that will
enable a port for 9600 8,1,N. Modify the command as necessary for your terminal.

pmadm -a -p zsmon -s a001s -fu -i root -v `ttyadm -V`
-m "`ttyadm -d /dev/term/a01s -l 9600 -s /usr/bin/login`"

where:

zsmon  is the port monitor tag. Use a different one if appropriate.

a001s  is the name of the device. Refer to your Digi manual for your device names.

-l 9600  sets the port for a baud rate of 9600.

 2. Verify that the port is enabled with this command:

pmadm -l

Using ditty

With the ditty command, display options such as flow control settings, speed and transparent print
settings can be configured for your Digi TTY ports. The ditty command is installed in the
directory /opt/DIGIras/bin.

Important: Ditty commands should be manually inserted in the startup file /etc/rc2.d/S99ditty (or
any other file beginning with “S99” in the directory) if they are to be executed every time the
system boots.

To configure ports with ditty, see Appendix B: Transparent Print Setup (UNIX Systems).

For detailed information on the ditty command, refer to ditty man page which is inserted into man
pages when the driver is installed.

Note: To use the man pages for the first time, the path /usr/share/man must be added to the system
MANPATH. Here is an example of such a command that is sufficient in most cases. At a root
prompt on the system, enter:

MANPATH=$MANPATH:/usr/share/man
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fastbaud Data Rate Mapping

Use this procedure to enable data rates that exceed the maximum data rate supported by some
UNIX operating systems. If your operating system supports data rates up to (or beyond) 921600,
this procedure is unnecessary. See fastbaud Data Rate Mapping Table on page A-6 for a table of
correspondences showing how data rates are mapped when fastbaud is enabled.

Procedure

 1. Enter the following command at a command prompt:

ditty fastbaud [device_name]

where device_name is the name of the TTY device on which you want fastbaud
activated. If no device is specified, the command acts on stdout.

 2. Repeat Step 1 for all devices that require fastbaud data rate mapping. (The commands may
be added to a startup script to cause them to run automatically whenever the system is
started.)

To cancel fastbaud data rate mapping, enter the following command:

ditty -fastbaud [device_name]

Example:

If fastbaud is active for a port on an AccelePort Xp adapter, setting the data rate to 600 results in
an actual data rate of 921600.

Configuring a Device for a Terminal

Use this procedure to configure a Digi device for a terminal. Consult your Solaris documentation
for more information on configuring a serial device for a terminal.

Procedure

 1. Connect a proper cable between the port and terminal. See the AccelePort Cable Guide.

 2. Invoke admintool either through a window interface, or by entering this command at a root
prompt:

admintool

Note: An alternative to admintool is the pmadm command. See Configuring Ports with
pmadm.

 3. Choose Browse > Serial Ports.

 4. Choose a device.

 5. Choose Edit > Modify.
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 6. Configure the device parameters. Typically a terminal device is set to Terminal-Hardwired
and Service Enabled.

 7. Set the Baud Rate.

Note that the default admintool baud rates cycle, meaning the speed at the end of the
corresponding /etc/ttydefs entry, is different than the speed at the beginning of the entry. It
is preferable to configure a device to a fixed rate.

As an example, this line can be added to /etc/ttydefs and used as a fixed rate for devices:

38400N:38400 hupcl:38400 hupcl::38400N

If a custom /etc/ttydefs entry is created and used, set Baud Rate to Other and enter the
/etc/ttydefs identifier (e.g. 38400N).

Troubleshooting Tips

 1. If a login does not appear on the terminal, try disabling and reenabling the device in
admintool.

 2. If a cycling baud rate is used and scrambled characters appear on the terminal screen, hitting
the Enter key several times at the terminal may cause the port to change baud rates and
display a login.

 3. If a cycling baud rate is used and scrambled characters appear on the terminal screen,
change the baud rate to a fixed /etc/ttydef entry matching the terminal’s settings.

Configuring a Device for a Printer

Use this procedure to configure a Digi device for a printer. See your Solaris documentation for
more information on configuring a serial device for a printer.

Procedure

 1. Connect a proper cable between the port and printer. See the AccelePort Cable Guide on the
Digi Access Resource CD.

 2. Set flow control, speed and other options on the port to match your printer settings.

Example 1: Setting Hardware Flow Control To set hardware flow control on the port
(which is usually more stable than software flow control), edit the file /etc/rc2.d/S99digi
(create it if necessary) and add the following commands:

cat < /dev/dty/a001s > /dev/null &
ditty forcedcd 9600 ctspace -ixon -ixoff -ixany
/dev/dty/a001s

This example uses the device /dev/dty/a001s as an example. Substitute your device name
when you use the ditty command.

Note that this example sets the port speed to 9600. It also sets the port to flow-control
(pause) when the CTS (Clear to Send) signal on the port is low or not active. This requires
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the printer to be configured to hardware flow control (typically DTR flow control) and the
printer’s control signal, typically DTR (Data Terminal Ready), tied to the port’s CTS pin.

It is possible that your printer uses a control signal other than DTR. This may affect your
cabling. If you have cabling concerns, see the AccelePort Cable Guide on the Digi Access
Resource CD. If you have concerns about which ditty hardware flow control option(s) to
enable, see Appendix A: Setting TTY Options (UNIX Systems).

Example 2: Setting Software Flow Control To use software flow control, edit the file
/etc/rc2.d/S99digi (create the file if necessary) and add the following commands:

cat < /dev/dty/a001s > /dev/null &
ditty forcedcd 9600 ixon ixoff -ixany /dev/dty/a001s

This example uses the device /dev/dty/a001s as an example. Substitute your device name
when you use the ditty command. Note that this example sets the port speed to 9600.

 3. For the settings to initially take effect, either enter the previous commands at a command
prompt, use the sh command to manually execute the file /etc/rc2.d/S99digi, or reboot the
Solaris system.

Configuring a Device for a Modem

Use this procedure to configure a Digi device for a Dial-in/Dial-out modem connection.
Configuring a device for a modem requires familiarity with both the operating system and the
modem being used. While the following procedure is sufficient for most cases, it may be
necessary to take additional steps to properly configure your modem or to set up the operating
system for a specific application.

Note: This procedure uses the devices /dev/dty/a001s and /dev/dty/a001s as examples. Substitute
your device names where necessary.

Procedure

 1. Connect a proper cable between the port and modem. See the AccelePort Cable Guide on
the Digi Access Resource CD.

 2. Connect to the modem with tip. tip -38400 /dev/dty/a001s The speed (38400) and device
(/dev/dty/a001s) are used as examples in this example.

 3. Enter one of the following commands, depending on your modem:

Command Comment

AT&H1&B0&W Typically works for a USRobotics modem

AT&H1&W Typically works for a Hayes or other modem

 4. Terminate the connection to the modem with a tilde followed by a period:

~.
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 5. Access admintool by entering this command at a root prompt:

admintool

 6. Choose Browse > Serial Ports.

 7. Choose a device.

 8. Choose Edit > Modify.

 9. Configure the device parameters. A terminal device is typically set to Terminal-Hardwired
and Service Enabled.

 10. Set the Baud Rate. Note that the default admintool baud rates cycle, meaning the speed at
the end of the corresponding /etc/ttydefs entry is different than the speed at the beginning of
the entry. It is often preferable to set them to a fixed rate. As an example, this line can be
added to /etc/ttydefs to configure the device for a 38400 fixed rate:

38400N:38400 hupcl:38400 hupcl::38400N

If a custom /etc/ttydefs entry is used, set Baud Rate to Other and enter the /etc/ttydefs
identifier (e.g. 38400N).

 11. Edit the file /etc/rc2.d/S99digi (create it if necessary) and add the following command to it:
ditty rtspace ctspace /dev/dty/a001m The device a001m is used as an example in the
previous ditty command.

Uninstalling the Driver

Use this procedure to remove a Digi Solaris driver from your system.

Procedure

 1. Enter the following command at a root prompt:

pkgrm drivername

where drivername is the name of the Digi driver.  For a list
of software and drivers on your system, use this command:

pkginfo | more

 2. Follow the prompts.
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Chapter 7. Novell NetWare Software Setup
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System Requirements

The AccelePort Novell NetWare device driver is designed to work on NetWare versions 4.11, 4.20
and 5.x.

Master Setup Process

Follow these steps to set up and install the NetWare AIO driver for the AccelePort Xp family.

 1. Install the driver. See one of the following: Installing Drivers from the Server Console on
page 7-2 or Installing Drivers from a Windows Client on page 7-4.

 2. Create a driver load command line for AUTOEXEC.NCF. See Configuring and Loading
Drivers on page 7-4.

 3. Create a Communication Agent load command line for AUTOEXEC.NCF. See Loading the
PortAssist Manager Communication Agent: Novell NetWare on page 7-6. This enables
PortAssist Manager to interact with the adapter.

Installing Drivers from the Server Console

Use this procedure to install a Digi Novell NetWare driver from the server console.

Requirements

 1. Your server must be equipped with a CD-ROM drive. If it is not so equipped, you can
install the drivers from a Windows client that has a CD-ROM drive (see Installing Drivers
from a Windows Client).

 2. You need to know whether your CD-ROM is DOS-mounted or a Novell-mounted. If it is
DOS-mounted, the CD-ROM drive is accessible to DOS applications and NetWare
applications without mounting.

If your CD-ROM drive is Novell-mounted, you must be sure that all of the Novell CD-
ROM device drivers are loaded, insert the CD, and enter the following command to mount it
before you begin your installation:

cd mount digi_cd

NOTE: NetWare 5.x will automatically mount the CD if the CD-ROM device drivers are
loaded.
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Procedure

 1. At the system command prompt, enter one of the following (the command differs between
NetWare versions 4.x and 5.x):

load install (NetWare 4.11 and later)
load nwconfig (NetWare 5.x)

A Novell menu will be displayed.

 2. Choose Product Options > Other Installation Actions > Install a Product Not Listed.

 3. Choose a source directory from which the drivers will be copied:

 4. Press F3, then specify the path to the CD-ROM drive, as shown below:

Dos Mounted Novell-Mounted

Drive:\Novell\RAS digi_cd:\Novell\RAS

where Drive is the drive letter of the CD device under DOS.

 5. Choose Install Product from the menu.

 6. At the prompt, choose the server on which you want driver files installed.

 7. At the Start installation? prompt, choose Yes.

 8. When the installation is complete, exit the installation and then bring down and restart the
server.
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Installing Drivers from a Windows Client

Use this procedure to install a Digi Novell NetWare driver from a Windows client.

Requirements

Before you begin this procedure, the NetWare server SYS volume must be mapped as a network
drive on your Windows computer, for example: 

\\server_name\SYS 

where server_name is the name of the NetWare server.

Procedure

 1. From the Start menu, choose Run.

 2. Browse to the CD drive and run digi.exe.

 3. Choose Novell NetWare.

 4. Choose the driver for your Digi product.

 5. Choose Install Software.

 6. Follow the prompts.

Configuring and Loading Drivers

To cause the driver to load automatically during boot, add a load command line in the
AUTOEXEC.NCF file. Use install.nlm (NetWare 4.x) or nwconfig.nlm (NetWare 5.x) to do this:
choose NCF Options > Edit AUTOEXEC.NCF.

 1. Xp adapters need only a single load command even if there are multiple Xp adapters in the
system. Exception: If the name= parameter is used, a separate load command must be issued
for each Xp adapter.

 2. All load commands for Digi ISA adapters must come before the Xp adapter load command.

 3. Configure the driver by supplying values for these parameters in the load command:

load aiodgdm [name=bname] [altpin=mask] [fastbaud] 
[custombaud=rate]

The parameters have these values:

name=bname (optional)

Use this parameter to choose a name for the adapter. A name is assigned by the driver if you
do not choose one.

Possible values: Up to 10 alphanumeric characters.

Example: name=digiboard1
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IMPORTANT! If name= is specified in the command line, each Xp adapter requires its
own load command.

altpin=mask (optional)

Include this parameter when you are using an RJ-45 10-pin connector assembly and want
to attach peripheral cabling with 8-pin plugs. This option switches the DCD (Data Carrier
Detect) signal from pin 10 of a 10-pin RJ-45 connector to pin 2 (this corresponds to pin 1
of an 8-pin plug).

Possible values: Use the parameter with no value to cause all ports to use the alternate
wiring. Otherwise, use a hexadecimal mask up to 16 digits in length to use alternate
wiring for up to 64 individual ports. Bit zero is port one. A value of one turns on the
alternate wiring.

Example: altpin=f0 causes ports 5 to 8 to use alternate wiring.

IMPORTANT! Use this option only for ports equipped with 10-pin RJ-45 connectors.

fastbaud (optional)

Include this parameter to cause the adapter to interpret a slower baud rate setting as a
faster baud rate. If it is included on the load line, the adapter will interpret the following
baud rate settings:

 1. 300 and 1200 baud as 230K baud

 2. 600 and 2400 baud as 460K baud

 3. 50 baud as 920K baud

custombaud=rate (optional)

Include this parameter to cause the adapter to map a baud rate setting of 4800 a specific
baud rate specified in rate. For example, custombaud=921600 causes an application set
for 4800 baud to communicate at 920k baud instead.
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Loading the PortAssist Manager Communication Agent: Novell
NetWare

Use this procedure to start the PortAssist Manager communication agent and, if you so choose, to
ensure it is automatically loaded each time the system is initialized. PortAssist Manager can
monitor and manage your Digi adapters. To read about and use PortAssist Manager, go to
PortAssist Manager Users Guide on the Digi Access Resource CD.

Requirements

The drivers for the Digi adapters to be monitored by PortAssist Manager must have already been
installed.

Procedure

From the Novell Netware Console, do the following:

 1. Determine how you will want to use the communication agent.

If you want to manually load the communication agent (without booting),  enter at the
command line prompt:

load digipama [UDP_port_number]  

where UDP_Port_Number is the number of the communication agent’s UDP port, if
different from the default.

Note: The default UDP number is 2362, which was assigned to Digi by the Internet
Assigned Number Authority (IANA). Although you can change this port number, it should
not be necessary. If another application uses it, the best way to resolve the conflict is to
reconfigure the application to use another UDP port number, one that has not been assigned
by the IANA. 

If you want the communication agent automatically loaded at startup, continue with the next
step.

 2. Enter one of the following commands:

load install (NetWare 4.11 and later)
load nwconfig (NetWare 5.x)

 3. Choose NCF Options > Edit AUTOEXEC.NCF.

The autoexec.ncf file is displayed.

 4. Navigate to the end of the file.

 5. Add the following line:

load digipama

 6. Save the file and exit the editor.
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 7. Restart the server to load the communication agent.

 8. Verify that the communication agent is installed by entering:

modules digipama

If the agent has been properly loaded, a message appears indicating that the module is
loaded.

Note: If you no longer want the communication agent loaded automatically, delete the command
you entered in Step 5.

Uninstalling the Driver

This topic describes how to remove a driver from the Novell NetWare Installed Products List.

IMPORTANT: Use this full procedure only if the driver was installed from the server console. If
the driver was installed from a Windows client, perform only step 6 (drivers installed from a
Windows client are not registered in the Novell driver database, so steps 1-5 are unnecessary).

Procedure

To remove a driver from the Installed Products list, do the following:

 1. From the NetWare server console, enter the following:

load install (NetWare 4.x)
load nwconfig (NetWare 5.x)

 2. Choose Product Options > View > Configure > Remove Installed Products.

 3. Highlight the Digi driver to remove.

 4. Press the Delete key.

 5. Choose Yes when prompted to remove the driver.

 6. Remove the load aiodgdm command line from the AUTOEXEC.NCF file.

Note: Novell does not remove the actual driver files, just their entry into the Novell driver
database. To completely delete all files, follow normal Novell procedures to delete a file.
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Appendix A.  Setting TTY Options (UNIX Systems)

AccelePort UNIX device driver packages include a command, ditty (stty-digi for AIX systems),
which is a superset of stty, and may be used to set and display the device options for Digi
AccelePort devices.

The general command format is:

ditty [-a] [-n ttyname] [option(s)] [ttyname]

In AIX, substitute the command, stty-digi, for ditty:

stty-digi [-a] [-n ttyname] [option(s)] [ttyname]

With no options, ditty displays all Digi special driver settings, modem signals, and all standard
parameters displayed by stty(1) for the TTY device referenced by standard input.

Command options are provided to change flow control settings, set transparent print options, force
modem control lines, and display all TTY settings. Any unrecognized options are passed to stty(1)
for interpretation.

ditty commands may be executed from the command line, or placed in a startup script to be run
whenever the system is booted.

The options are:

-a Display all of the unique Digi option settings, as well as all of the standard
TTY settings reported by stty -a.

-n ttyname Set and display options for the given TTY device, instead of standard input.
This option may be specified multiple times to perform the same operation on
multiple TTYs.

ttyname Set and display options for the specified TTY device. Replace ttyname with
the TTY pathname (such as /dev/ttya01s, /dev/term/a01 or /dev/dty/a001s,
depending on your operating system). This option may be used on a modem
control line when no carrier is present.
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The following options specify transient actions to be performed immediately:

break Send a 250 MS break signal out on the TTY line.

clear Clear the tbusy flag in the channel structure to free the port.

NOTE: This option is supported only in UnixWare, OpenServer and Solaris
operating systems.

cspeed n Set the port speed to n bps, where n is an integer value. Available only on Xr,
Xem and Xp adapters.

NOTE: This option is supported only in UnixWare, OpenServer and Solaris
operating systems.

flush Immediately flush (discard) TTY input and output.

flushin Flush TTY input only.

flushout Flush TTY output only.

The following options specify actions which are not sticky, meaning that the changes are cancelled
when the device is closed, and that the device will use the default values the next time it is opened.

stopout Stop output exactly as if an XOFF character were received.

startout Restart stopped output exactly as if an XON character were received.

stopin Activate flow control to stop input.

startin Release flow control to resume stopped input.

[-]dtr
Raise [drop] the DTR modem control line, unless DTR hardware flow control
is selected.

[-]rts
Raise [drop] the RTS modem control line, unless RTS hardware flow control
is selected.
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The following options are sticky—the effects continue until the system is rebooted or until the
options are changed.

[-]printer Forces the port to stay open so that non-sticky parameters such as baud rate
and flow control are not reset to default values.

NOTES:

• This option is supported only in UnixWare, OpenServer and Solaris
operating systems.

• This option is not supported by RealPort.

[-]fastcook Perform cooked output processing on the adapter itself, to minimize use of
host resources.

NOTES:

• This option is supported only in OpenServer and AIX operating
systems.

• This option is not supported by RealPort.

[-]fastbaud
Alter the baud rate tables to permit the use of data rates that are beyond the
range supported by the operating system. See fastbaud Data Rate Mapping
Table on page A-6.

[-]rtspace
Enable [disable] RTS hardware input flow control, so RTS drops to pause
remote transmission.

[-]ctspace
Enable [disable] CTS hardware output flow control, so local transmission
pauses when CTS drops.

[-]dsrpace
Enable [disable] DSR hardware output flow control, so local transmission
pauses when DSR drops.

[-]dcdpace
Enable [disable] DCD hardware output flow control, so local transmission
pauses when DCD drops.

[-]dtrpace
Enable [disable] DTR hardware input flow control, so DTR drops to pause
remote transmission.

[-]forcedcd
Disable [re-enable] carrier sense, so the TTY may be opened and used even
when carrier is not present.
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edelay n edelay is a tunable parameter used to set the number of milliseconds of delay
between the time the first character arrives after a period of no characters and
notification of its arrival to the host. This is also referred to as the wakeup rate
between the host adapter software (FEP/OS) and the host device driver. This
has the advantage of reducing host overhead by allowing the host to process
larger blocks of incoming data. Larger edelay values result in more characters
being sent in a given time period. This will reduce host processor overhead
and increase overall system throughput. Smaller edelay values result in fewer
characters being sent in a given time period. This will increase character
response time and increase host processor overhead. The default value for
edelay is 100. This is a good value for normal TTY activity like typing. For
some applications like uucp, decreasing the edelay value may increase
character throughput, but will result in increased host (system) overhead. For
applications receiving continuous input at high speeds, increasing edelay will
result in lowering host overhead and increasing overall system throughput. A
value of 250 is reasonable.

NOTES:

• This option is supported only in UnixWare, OpenServer and AIX
operating systems.

• This option is not supported by RealPort.

startc c Sets the XON flow control character. The character may be given as a
decimal, octal or hexadecimal number. Octal numbers are recognized by the
presence of a leading zero, and hexadecimal numbers are denoted by a leading
“0x”. For example, the standard XON character, <CTRL-Q>, can be entered
as “17” (decimal), “021” (octal) or “0x11” (hexadecimal).

stopc c Sets the XOFF flow control character. The character may be given as a
decimal, octal, or hexadecimal number (see startc, above, for format of octal
and hexadecimal numbers).

astartc c Sets auxiliary XON flow control character. The character may be given as a
decimal, octal, or hexadecimal number (see startc, above, for format of octal
and hexadecimal numbers).

astopc c Sets auxiliary XOFF flow control character. The character may be given as a
decimal, octal, or hexadecimal number (see startc, above, for format of octal
and hexadecimal numbers).

[-]aixon Enables auxiliary flow control, so that two unique characters are used for
XON and XOFF. If both XOFF characters are received, transmission will not
resume until both XON characters are received.
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maxcps n Sets the maximum Characters Per Second (CPS) rate at which characters are
output to the transparent print device. The rate chosen should be just below
the average print speed. If the number is too low, printer speed will be
reduced. If the number is too high, the printer will resort to flow control, and
user entry on the terminal will be correspondingly impaired. Default is 100
CPS.

maxchar n Sets the maximum number of transparent print characters the driver will place
in the output queue. Reducing this number increases system overhead;
increasing this number delays operator keystroke echo times when the
transparent printer is in use. Default is 50 characters.

bufsize n Sets the driver’s estimate of the size of the transparent printer’s input buffer.
After a period of inactivity, the driver bursts this many characters to the
transparent printer before reducing to the maxcps rate selected above. Default
is 100 characters.

onstr "s" Defines the terminal escape sequence to direct subsequent data to the
transparent printer.

s is a string of ASCII characters, enclosed in quotes, that command the
terminal to enter transparent printing mode. An arbitrary octal character xxx
may be given as \xxx.

For example, the sequence <Esc>[5i would be entered as: "\033[5I".

offstr "s" Defines the terminal escape sequence to stop directing data to the printer.

s is a string of ASCII characters, enclosed in quotes, that command the
terminal to enter transparent printing mode. An arbitrary octal character xxx
may be given as \xxx.

For example, the sequence <Esc>[5i would be entered as: "\033[5I".

term t Sets the transparent printer on/off strings to values found in the internal
default table. Internal defaults are used for the following terminals: adm31,
ansi, dg200, dg210, hz1500, mc5, microterm, multiterm, pcterm, tvi, vp-a2,
vp-60, vt52, vt100, vt220, wyse30, wyse50, wyse60, or wyse75. If the
terminal type is not found in the internal default table, then ditty reads the
terminfo entry for the terminal type and sets transparent print on/off strings to
values given by the mc5/mc4 attributes found there.
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fastbaud Data Rate Mapping Table

Use the table below to see how setting fastbaud affects data rates.

Xp Xe Xr, Xem,
EPC/X Xr 920 C/X

Specified
Data Rate:

Data Rate
Mapped to:

Data Rate
Mapped to:

Data Rate
Mapped to:

Data Rate
Mapped to:

Data Rate
Mapped to:

50 57600 57600 57600 57600 57600

75 76800 76800 76800 76800 75

110 115200 115200 115200 115200 115200

134 131657 14400 14400 14400 14400

150 153600 28800 57600 57600 57600

200 230400 200 230400 230400 200

300 460800 300 76800 76800 300

600 921600 600 115200 115200 115200

1200 1200 1200 230400 230400 1200

1800 1800 1800 28800 28800 28800

2400 2400 2400 2400 460800 2400

4800 4800 4800 4800 921600 4800

9600 9600 9600 9600 9600 9600

19200 19200 19200 19200 19200 19200

38400 38400 38400 38400 38400 38400
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Appendix B. Transparent Print Setup (UNIX Systems)

About Transparent Printing

Most terminals have an auxiliary port that can be connected to a serial printer. When this port is
configured as a transparent printer port, print jobs may be run simultaneously with normal
terminal operation.

Data bound for the printer is preceded by a terminal escape sequence that turns on transparent
printing, and followed by a sequence which turns transparent printing off.

Transparent printer devices are created in /dev and, after configuration, are accessed in the same
manner as a printer on a regular serial port. Data sent to a transparent printer device is
automatically “wrapped” in the transparent print on/off command strings for the specified printer.
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Configuring Transparent Printers

The Digi device driver uses six parameters to configure transparent printing. These options are set
by the ditty command (stty-ncxa on AIX systems), and are described below.

maxcps n Limits the maximum printer port character-per-second data rate. n should be set to the
minimum character rate the printer can sustain in typical use.

maxchar n Limits the number of characters queued to the printer ahead of terminal output. Lower
numbers increase system overhead, higher numbers result in keystroke echo delays. A
value of 50 is generally a good compromise at 9600 baud.

bufsize n This parameter should be set to a value just below the printer’s buffer size. After a
period of inactivity, the driver will burst up to this many characters to the printer to fill
the print buffer before slowing to the maxcps rate.

onstr "s" Defines the terminal escape sequence to direct subsequent data to the transparent
printer.

s is a string of ASCII characters, enclosed in quotes, that command the terminal to enter
transparent printing mode. An arbitrary octal character xxx may be given as \xxx.

For example, the sequence “<Esc>[5I” would be entered as: "\033[5I".

offstr "s" Defines the terminal escape sequence to stop directing data to the printer.

s is a string of ASCII characters, enclosed in quotes, that command the terminal to enter
transparent printing mode. An arbitrary octal character xxx may be given as \xxx.

For example, the sequence “<Esc>[4I” would be entered as: "\033[4I".

term t Sets the transparent printer on/off strings to values found in the internal default table.
Internal defaults are used for the following terminal types: adm31, ansi, dg200, dg210,
hz1500, mc5, vt100, vt220, vt320, vt420, wang2x36, wyse30, wyse50, wyse60 or
wyse75. If the terminal type is not found in the internal default table, then ditty reads
the terminfo entry for the terminal type and sets the transparent print on/off strings to
the values given by the mc5/mc4 attributes found there.
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Transparent Print Setup Examples

Use the ditty program to set up your terminal for transparent printing. The following examples are
for SCO OpenServer systems; for other UNIX systems, substitute the appropriate device names
for the ones in the examples.  For AIX systems, substitute stty-ncxa for ditty.

Example 1:

The following command configures the transparent print options for a DEC VT100 terminal
connected to /dev/ttya01 (note that the printer will be called /dev/pra01). maxcps, maxchar and
bufsize are left to defaults. Enter:

ditty term vt100 /dev/ttya01

Example 2:

The following example uses onstr and offstr arguments (this sets the terminal to use ANSI
Standard). Again maxcps, maxchar, and bufsize are defaults. Enter (on a single command line):

ditty onstr \033[5i offstr \033[4i /dev/ttya01

Example 3:

This example command sets the transparent print option for a WYSE30 terminal, with maxcps of
75, a maxchar of 100, and a printer buffer size, bufsize, of 1000. Enter (on a single command
line):

ditty term wyse30 maxcps 75 maxchar 100 bufsize 1000 /dev/ttya01
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